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GLOSAR DE TERMENI

	CAD
	Computer Aided Design (proiectare asistată de calculator) sau Computer Aided Drafting (desenare asistată de calculator)

	Layer
	Strat în care pot fi desenate anumite părţi din desene mai complexe, părţi care au comune culoarea, tipul de linie folosit etc.

	Desene prototip (template)
	Desene în care sunt predefinite elemente de bază, cum ar fi unităţile de măsură, culorile, tipurile de linie. Sunt folosite ca elemente iniţiale pentru un desen nou. Fişierele sunt salvate cu extensia .dwt.

	.dwg
	Extensia unui fişier desen (drawing) creat de AutoCAD

	Colimator
	Cursor care apare pe ecran sub forma a două linii care se intersectează

	Entitate
	Element grafic de bază al unui desen

	Cotare
	Măsurarea şi marcarea pe desen a dimensiunii unei entităţi


SISTEMUL DE COORDONATE

AutoCAD foloseşte sistemul de coordonate universal WCS (World Coordinate System) bazat pe coordonatele rectangulare x,y,z cu originea sistemului 0,0,0.

Elementele ferestrei de lucru

·  Bara de titlu (title bar);

·  Bara de meniu (menu bar);

·  Bara de instrumente standard (toolbar);

·  Bara mobila cu instrumente;

·  Suprafaţa de desenare;

·  Fereastra de comanda în care se vizualizează istoricul comenzilor “Command:” cere comanda utilizatorului; 

·  Bara de stare (starea diferitelor moduri operaţionale) ;

·  Cursorul in cruce (reprezinta cele doua axe de coordonate), sageata (pentru accesare meniuri şi bare de instrumente, caseta de selecţie.

·  bare de derulare
Introducerea comenzilor în AutoCAD
   a)Tastarea comenzii la prompterul de comenzi

   b) din meniurile derulante

   c) din meniurile grafice (Toolbars)

Etapele care trebuie urmate în realizarea unui desen într-o sesiune de lucru AutoCAD 

   -deschiderea unui desen

   -stabilirea limitelor

   -stabilirea poziţiei sistemului de coordonate

   -alegerea unităţilor de măsură

   -controlul afişării imaginii

   -realizarea desenului cu ajutorul modurilor Snap,Grid,Ortho,Polar Traking

   -salvarea desenelor

   -închiderea sesiunii de lucru  AutoCAD

Introducere în operaţiile cu fişiere

· Crearea unui desen nou: File/New;

· Deschiderea unui desen existent: File/Open se cauta in fereastra Select File fisierul dorit;

· Salvarea unui desen nou: File/Save As se va defini desenul Nume.dwg;

· Salvarea unui desen deja denumit: File/Save;

· Redenumirea unui desen existent: File/Save As;

· Inchiderea fişierului AutoCAD: File/Exit Se cere salvarea fişierului dacă este nesalvat.

Stabilirea limitelor desenului FORMAT- DRAWING LIMITIS Limitele unui desen va ajuta sa stabiliti suprafata de lucru. Limitele pot fi considerate ca reprezentand perimetrul hartiei pe care realizati desenul. Principala utilizare a fixarii limitelor este furnizarea unui contur cu ajutorul caruia desenul sa fie incadrat pe o dimensiune de hartie stabilita. Limitele desenului se poate stabili prin comanda LIMITS. 

Limitele desenului sunt date prin fixarea colţului din stânga jos (lower left corner) şi a celui din dreapta sus (upper right corner). Dimensiunile 297, 210 sunt pentru pagina de format A4.

Alegerea unităţilor de măsură FORMAT- UNITS…

Comenzi de vizualizare

ZOOM // Meniul View: Zoom // Linie de comandă: zoom
 Măriri sau micşorări ale mărimilor aparente ale obiectelor.

Optiuni:

· All => Vizualizarea intregului desen

· Center => vizualizează o fereastră specificată prin centru şi înălţime (se defineşte ordinul de redimensionare) 
· Dynamic => Vizualizare dinamică cu un “view box” ales

· Extents => Vizualizează cea mai mică vedere care să cuprindă toate obiectele din desen
· Previous => Vizualizarea ecranului anterior

· Scale => Vizualizarea desenului la o scala impusa

· Windows => Vizualizarea elementelor dintr-o fereastră bine definită

· Realtime=>
• "click & drag" + in sus pentru a mări imaginea

• "click & drag" – in jos pentru a micşora imaginea
ieşire:apăsaţi Esc sau Enter, sau click-dreapta şi selectaţi "Exit"
· In => echivalent opţiiunii "scale 2X"
· Out=>echivalent opţiiunii "scale 0.5X"
PAN // Meniul View: Pan // Linie de comandă: pan.
Translatează ecranul în orice direcţie fără schimbarea caracteristicilor desenului.

Selectarea punctelor

Tehnici:

1. Indicarea poziţiei punctelor cu ajutorului cursorului de la mouse

2. Indicarea coordonatelor absolute prin tastare directă

3. Indicarea coordonatelor relative la punctul curent, specificând deplasarea pe orizontală, verticală sau pe direcţia dată de unghiul cerut, cu ajutorul simbolului @.

1.  Coordonate carteziene absolute (raportate la originea sistemului de coordonate), de forma X,Y.

Exemplu: 100,50

2. Coordonate carteziene relative (raportate la ultimul punct introdus) de forma @ΔX, ΔY.

Exemplu: @70,40

3. Coordonate polare absolute (raportate la originea sistemului de coordonate), de forma distanţă<unghi.

Exemplu: 50<75

4. Coordonate polare relative (raportate la ultimul punct introdus), de forma @distanţă<unghi.

Exemplu: @50<75

CONFIGURAREA SETARILOR DE TRASARE A DESENELOR

TOOLS →DRAFTING SETTINGS

Caseta DRAFTING SETTINGS contine trei etichete Eticheta Snap and Grid – controleaza setarile pentru modurile de lucru Snap (fixare) si Grid (grila), distanta dintre punctele grilei (spacing) pe directiile X si Y pentru ambele. Eticheta Polar
tracking permite deplasarea cursorului după direcţii determinate de un pas unghiular, faţă de punctul curent.(track – a urmări). Eticheta Object snap permite indicarea unui punct prin acroşarea cursorului (ca un magnet) într-un un punct particular al unui obiect existent.
COMENZI PENTRU DESENARE 

DRAW →LINE - desenarea unei linii sunt necesare două puncte, care pot fi date fie prin coordonate carteziene, fie prin coordonate polare. De asemenea, pot fi folosite atât coordonatele absolute, cât şi cele relative. 
DRAW →RAY – foloseste la desenarea unei drepte infinite la un capat

DRAW →XLINE– foloseste la desenarea unei drepte infinite  in ambele directii
DRAW →MLINE - foloseste la desenarea unui set de linii paralele, cu ajutorul unei singure comenzi 
DRAW →CIRCLE - desenarea unui cerc pot fi alese mai multe variante, după cum sunt cunoscute puncte prin care trece, centrul, raza, diametrul sau entităţi la care cercul este tangent.

DRAW →ARC - desenarea unui arc de cerc pot fi alese mai multe variante, după cum se încadrează respectivul arc în ansamblul din care face parte. 

DRAW →PLINE - Poliliniile sunt cele mai utilizate obiecte in AutoCAD. Ele pot inlocui obiectele de bază, cum ar fi liniile, arcele, solidele, imbinand caracteristicile acestora intr-un singur obiect.
DRAW →POLYGON - Crează poligoane regulate cu 3 până la 1024 laturi. Pentru trasarea unui poligon se introduc numarul de laturi si a coordonatelor unui cerc inscris sau circumscris poligonului.
DRAW →RECTANGLE - Trasează polinii rectangulare
DRAW →DONUT- Deseneaza un inel a carui grosime a liniei se specifica prin diametrul interior si cel exterior. Daca diametrul interior este 0 atunci se deseneaza un punct.
DRAW →SPLINE  - organizeaza o insiruire de puncte, prin intermediul unei curbe.

DRAW →ELLIPSE - Trasează elipse şi arce eliptice. Pentru trasarea unei elipse este necesar sa cunoastem centrul, raza mare si raza mica.

DRAW →POINT - Trasează puncte cu un grafism specificat.

DRAW →TABLE – permite editarea tabelelor in cadrul unui desen.
DRAW →REVCLOUD – permite crearea “norilor de revizie” care trebuie sa fie inchisi.
DRAW →REGION 

O regiune reprezinta o suprafata creata din obiecte care formeaza o forma inchisa, cunoscuta ca bucla. Comanda Region este folosita penru a transforma obiectele in regiuni, mai degraba decat pentru a le desena (adica vei avea nevoie sa desenezi mai intai forma inchisa). Odata ce o regiune este creata, se poate sa existe o mica modificare vizuala adusa desenului.

DRAW →WIPEOUT

Un Wipeout (imagine stearsa) este un obiect tip imagine. Cel mai adesea este folosit pentru a masca o parte a unui desen, pentru claritate. De exemplu, ai putea dori sa adaugi text unei parti complicate a unui desen. Ai putea folosi un Wipeout pentru a masca zona din spatele unui text pentru ca textul sa poata fi usor de citit.

Cateva din comenzile descrise mai sus :

	Command: _pline
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	Command: _spline
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	Command: _mline
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	Command: _ellipse
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	Command: FILL

Enter mode [ON/OFF] <ON>: OFF

Command: _donut
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	Command: FILL

Enter mode [ON/OFF] <OFF>: ON

Command: _donut
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COMENZI PENTRU EDITARE 

MODIFY →ERASE – permite stergerea unui obiect din fereastra de lucru.

MODIFY →COPY permite copierea obiectelor din desen necesitand definirea unui punct fata de care se va face copierea.
MODIFY →MIRROR – permite copierea unui obiect existent cu sau fara pastrarea originalului fata de o axa de simetrie.
MODIFY →OFFSET – permite trasarea unei noi entitati grafice de acelasi tip cu cea selectata ca referinta si paralele cu aceasta

MODIFY →ARRAY - comanda creează copii ale unui obiect, într-o reţea cu formă matriceală sau circulară. Evident, se începe cu desenarea obiectului care urmează să fie copiat, după care va fi creată reţeaua în care vor fi dispuse copiile.

MODIFY →MOVE – permite mutarea uneia sau mai multe entitati ale desenului dintr-o pozitie in alta a acestuia, fara a afecta marimea sau orientarea obiectelor.

MODIFY →ROTATE – asigura modificarea orientarii entitatilor specificate prin rotirea lor in jurul unui punct de baza precizat de utilizator.

MODIFY →SCALE – permite modificarea dimensiunilor entitatilor grafice prin aplicarea unor factori de scala precizati de utilizator.

MODIFY →STRETCH – permite mutarea grupurilor de obiecte. Aceste obiecte vor fi alese cu ajutorul unei cutii de selectare. Indepartarea elementelor nedorite di cutia de selectare se face prin tastarea caracterului R in fereastra de comanda si prin selectarea acestora, cu ajutorul mouse-lui 

MODIFY →TRIM – permite stergerea partiala a unor obiecte, punctele de intrerupere fiind date de intersectiile cu un alt grup de obiecte care poarta denumirea de muchii de taiere.

MODIFY →EXTEND – permite prelungirea obiectelor pana la intersectarea ferma a unor granite definite de alte entitati grafice – limitele de extindere.

MODIFY →BREAK – este o comanda de stergere partiala.

MODIFY →CHAMFER - comanda este folosită pentru crearea colţurilor unei secvenţe de segmente de dreaptă; pentru fiecare segment pe care se aplică teşirea se alege distanţa până la care se va reteza linia.

MODIFY →FILLET - comanda este folosită pentru racordarea a două entităţi (segmente de dreaptă sau arce de cerc) folosind arce de cerc de rază impusă.

MODIFY →EXPLODE – folosita pentru a converti obiectele complexe, la linii individuale si la segmente de arc.

MODIFY →LENGTHEN – orice obiect, cum ar fi o linie sau un arc, poate fi alungit sau scurtat.

Cateva din comenzile pentru editare

	Command: COPY


	
[image: image7.png]




	Command:Mirror
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	Command: Offset
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	Command: _array
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	Command: Array


	[image: image13.jpg]


[image: image14.jpg]




	Command: move
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	Command: rotate
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	Command: scale
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	Command: extend
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	Command: break
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	Command chamfer
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COMENZI SI FACILITATI AJUTATOARE

TOOLS→INQUIRY→LIST – utila cand se doreste aflarea de informatii despre un anumit obiect sau despre un grup de obiecte.
TOOLS→INQUIRY→ID POINT – utilizata la identificarea coordonatelor unui punct
TOOLS→INQUIRY→DISTANCE – aflarea distantei dintre doua puncte alese de utilizator.
TOOLS→INQUIRY→AREA – calculul ariilor si a perimetrelor. Programul va calcula unind cu drepte punctele definite de utilizator.

TOOLS→INQUIRY→STATUS –ofera informatii complete despre obiectele desenate si chiar despre variabilele de sistem

DRAW→POINT→DIVIDE – este folosita la impartirea unui obiect intr-un numar de segmente introdus de la tastatura aflate la distante egale.
DRAW→POINT→MEASURE – cere sa se introduca distanta dorita dintre puncte
COMENZI DE CORECTARE A ERORILOR
MODIFY →ERASE – permite stergerea unui obiect din fereastra de lucru.

OOPS – reconstitue ultimul grup de obiecte sterse, anuland efectul comenzii ERASE, se introduce in fereastra de comanda
EDIT→UNDO – anuleaza efectul comenzii anterioare, se poate introduce numarul de pasi ce se doresc a fi anulati.

EDIT→REDO – anuleaza efectul comenzii UNDO

REIMPROSPATAREA IMAGINII

VIEW→ REDRAW - redesenează ecranul în viewport-ul curent şi curăţă blips-urile

VIEW→REGEN - redesenează toate obiectele din viewport-ul curent, prin recalcularea tuturor coordonatelor

VIEWRES – recalcularea rezolutiei spatiului de lucru, se introduce in fereastra de comanda

TEXTE SCRISE IN DESEN
	
	NUME
	COMANDA
	SCOP

	DRAW→TEXT
	Single line text
	Text 
	Scrierea unui singur rand de text

	
	Multiline text
	Mtext 
	Scrierea textului pe un numar mare de randuri. Prezinta optiuni pentru formatare avansata.

	IN FEREASTRA DE COMENZI
	Dtext
	Dtext 
	Scrierea textului pe un numar mare de randuri


PROPRIETATI SIMBOLICE SI DE EMFAZA 3D
CULOAREA OBIECTELOR, TIPURI DE LINIE

Orice obiect din AutoCAD are cel putin trei proprietati: culoare, strat si tip de linie. Stratul prestabilit al programului este 0. FORMAT→LAYER - Pentru a crea un strat nou se activeaza instrumentul Layer sau se foloseste comanda Layer aparad caseta de dialog Layer Properties Manager unde se activeaza New aparand un nou strat cu numele Layer1, putandu-i schimba numele tastand numele noului strat si Enter. Tot din aceasta caseta se poate sterge un strat selectandu-l si activand Delete.


FORMAT→LINETYPE Pentru a modifica tipul de linie se alege Continuous (linie continua) in coloana Linetype pentru a deschide caseta de dialog Select linetype. Deoarece Continuous este singurul tip de linie incarcat pana acum, executati clic pe butonul Load pentru a afisa caseta de dialog Load or Reload Linetypes. Tipurile de linii disponibile din fisierul acad.lin sunt afisate intr-o lista prevazuta cu o bara de derulare verticala. Selectati tipul de linie, apoi activati OK pentru a reveni in caseta Layer si verificati daca tipul de linie ales este asociat noului strat. Pentru a modifica culoarea liniei alese se activeaza patratelul alb din coloana Color deschizandu-se caseta Select color din care se selecteaza culoarea si se activeaza OK, inchizandu-se aceasta caseta, apoi OK inchizand caseta pentru crearea straturilor. Utilizarea factorului de scalare a tipului de linie se face prin comanda LTSCALE introducandu-se valoarea 0.075.

GROSIMI DE LINIE (LINEWEIGHT) FORMAT→ LINEWEIGHT sau din meniul derulant de pe bara de instrumente OBJECT PROPERTIES
GROSIMEA PE VERTICALA se optine cu comanda THICKNESS 
AutoCAD-ul ofera posibilitatea creerii de elemente 3D, pornind de la 2D, prin ingrosarea acestora din urma. In meniul Modify→Properties se introduce o valoare la optiunea THICKNESS, apoi se deseneaza un cerc, sau FORMAT→ THICKNESS 
Pentru vizualizare in 3D se apeleaza VIEW→3D VIEWS→ SE izometric
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HASURAREA
  Haşurarea suprafeţelor secţionate se face cu ajutorul comenzilor DRAW→ HATCH şi DRAW→GRADIENT, care au ca efect plasarea unui model de haşură într-o suprafaţă mărginită de un contur închis. Comanda HATCH se utilizează pentru a crea o haşură cu un anumit model în interiorul unui contur închis sau între contururi închise. Modelul de haşură poate fi ales dintr-un fişier de modele, prin introducerea numelui modelului respectiv, sau poate fi creat de către utilizator. La tastarea comenzii HATCH apare următoarea fereastră de dialog HATCH AND GRADIENT: 
Etape de lucru:
1. Alegerea modelului – opţiunea Tip and patern 

2. Alegerea unghiului de înclinare a modelului – opţiunea Angle 

3. Alegerea distanţei dintre elementele componente ale modelului de haşură – opţiunea Scale 

4. Alegerea punctului de plecare pentru aplicarea modelului – opţiunea Hatch origin 

5. Marcarea zonei de haşurare ( e foarte important să fie o zonă închisă) – opţiunea Boundaries cu următoarele posibilităţi: 

· Alegerea unui punct din interiorul zonei de haşurat (Add: Pick points) 

· Selectarea unor obiecte de haşurat (Add: Select objects) 

6. Aplicarea haşurii 

Comanda BOUNDARY creează o polilinie sau o regiune în jurul unei arii închise. 

Există, de asemenea, opţiuni pentru lăsarea unor zone libere în interiorul zonelor marcate pentru haşurare (zonele interne lăsate libere se numesc insule). 
Comanda GRADIENT permite aplicarea unor modele de haşură care să simuleze modul în care poate cădea lumina pe obiectul căruia le-au fost aplicate.


ADVANCED permite alegerea felului in care programul sa hasureze zonele islands (serii de obiecte inscrise unul in  altul):

· Stilul normal – se hasureaza orice suprafata inchisa, dinspre exterior spre centru;

· Stilul outer – se hasureaza doar prima suprafata inchisa intalnita, dinspre exterior;

· Stilul ignore – se hasureaza toata suprafata din interiorul conturului (ignora frontierele interioare)

Dupa toate aceste operatii se selecteaza Apply care inchide caseta.

COTAREA IN DESEN

Cotarea unui element dintr-un desen reprezintă marcarea grafică a dimensiunilor sale. Orice sesiune de cotare începe cu comanda DIM meniul DIMENSION şi continuă cu comenzi specifice fiecărui tip de element care trebuie marcat pe desen. 

Elementele unei cote:

· linia de cota (dimension line)

· linia ajutatoare (extension line)

· sageata (arrow)

· cota (dimension text) 




LINEAR DIMENSION Cotarea liniară poate fi orizontală, verticală sau oblică, creand cote paralele cu una din axele de coordonate.

BASELINE: indică opţiunea de cotare în paralel (faţă de un element comun, considerat referinţă) în cadrul comenzii.
CONTINUOUS: indică opţiunea de cotare în serie (în lanţ);
CENTER MARK – marcheaza centrul unui cerc

RADIUS - cotarea razelor de cerc prin precizarea lungimii razei precedată de litera R

DIAMETER - cotarea diametrului prin precizarea lungimii diametrului precedată de simbolul pentru diametre (Ø).

ANGULAR - Comanda este folosită pentru marcarea pe desene a măsurilor unghiurilor. 

Cateva dintre comenzile de cotare
	Command dimbaseline
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	Command dimcontinue
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	Command dimradius


	[image: image27.png]- 8l






	Command dimdiameter
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	Command dimangular
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PROIECTAREA TRIDIMENSIONALA
Obiecte in 3D

	Wireframe
	Ofera posibilitatea desenarii obiectelor tridimensionale cu ajutorul unor segmente de dreapta. Obiectele create nu vor avea nici volum, nici greutate.

	Suprafetele
	Acestea vor putea ascunde alte obiecte, insa nu au volum.

	Solidele 
	Ofera posibilitatea simularii complete a unor corpuri tridimensionale, cu masa si volum.


Vizualizare 3 D 

VIEW→3D VIEWS
	TOP
	Vizualizare deasupra obiectului

	BOTTOM
	Vizualizare dedesuptul obiectului

	LEFT
	Vizualizarea obiectului din partea stanga

	RIGHT
	Vizualizarea obiectului din partea dreapta

	BACK
	Vizualizarea obiectului din spate

	SW izometric
	Ofera posibilitatea vizualizarii obiectului pe diagonala, dintr-o pozitie echivalenta sud-vest al acestuia

	SE izometric
	Ofera posibilitatea vizualizarii obiectului pe diagonala, dintr-o pozitie echivalenta sud-est al acestuia

	NE izometric
	Ofera posibilitatea vizualizarii obiectului pe diagonala, dintr-o pozitie echivalenta nord-est al acestuia

	NW izometric
	Ofera posibilitatea vizualizarii obiectului pe diagonala, dintr-o pozitie echivalenta nord-vest al acestuia


DESENAREA SUPRAFETELOR
Desenarea unei suprafete intre doua linii curbe.

Command: _rulesurf

Current wire frame density:  SURFTAB1=6

Select first defining curve:

Select second defining curve:
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Desenarea unei suprafete de revolutie
Command: revsurf

Current wire frame density:  SURFTAB1=6  SURFTAB2=6 

Select object to revolve:

Select object that defines the axis of revolution:

Specify start angle <0>: 0

Specify included angle (+=ccw, -=cw) <360>: 360
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SUPRAFETE
DRAW→SURFACES →3D SURFACES – pentru a vedea in 3D se activeaza VIEW→3D VIEWS→SE Isometric
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Desenarea unui con
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Desenarea unui trunchi de con
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 Desenarea unei sfere
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Desenarea unui tor
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done-deseneaza emisfera suprioara a unei sfere
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dish-deseneaza semisfera inferioara a unei sfere


DESENAREA SOLIDELOR DRAW→SOLIDS
Crearea unui paralelipiped dreptunghic solid. Comanda BOX 

Crearea unui cilindru drept solid. Comanda CYLINDER 

Crearea conurilor drepte solide. Comanda CONE

Crearea unei sfere solide. Comanda SPHERE

Crearea unui tor solid. Comanda TORUS

Crearea solidelor de tip pana. Comanda WEDGE

Solide de revolutie. Comanda REVOLVE

Solide generate prin extrudare. Comanda EXTRUDE

Generarea solidelor de forma complexa. Operatii booleene aplicate obiectelor solide. MODIFY → SOLIDS EDITING Comenzile UNION, SUBTRACT, INTERSECT

Pentru a reuni volumul mai multor obiecte solide in volumul unui singur obiect, se utilizeaza comanda UNION.

Pentru a obtine volumul comun a doua sau mai multe solide, se utilizeaza comanda INTERSECT.

Comanda SUBTRACT dintr-un solid se poate extrage un alt solid.         VIZUALIZAREA UMBRITA A DESENELOR 3D –se face prin intermediul caii VIEW→SHADE
Dintre modalitatile de afisare realista a modelelor pe ecran, cea mai simplista alternativa este ascunderea muchiilor nevizibile. Colorarea suprafetelor este nivelul urmator. Nu numai ca muchiile nevizibile sunt ascunse, dar suprafetele sunt colorate. Obiectul nu mai este redat prin conturul sau, ci prin intreaga sa suprafata exterioara, colorata insa uniform. Randarea dezvolta afisarea realista, prin adaugarea texturilor de material, a luminii ambientale. Utilizarea surselor de lumina virtuale, impreuna cu generarea corespunzatoare a umbrelor apropie considerabil imaginea modelului de lumea reala. VIEW→RENDER
TIPARIREA DESENELOR
A) Alegerea imprimantei FILE→PLOT
B) Alegerea marimii hartiei

C) Pozitionarea desenului pe mediul de imprimare

D) Orientarea desenului

E) Setarea scarii

F) Optiuni pentru setarea grosimii liniei si pentru tiparirea obiectelor umbrite
TEST 1

1. Comanda Save as permite:

a) salvarea unui fisier sub un anumit nume;

b) deschiderea unui fisier ;

c) inchiderea sesiunii de lucru.

2. Comanda Open permite:

a) deschiderea unui fisier ;

b) crearea unui nou fisier;

c) inchiderea sesiunii de lucru

3. Pentru stabilirea unitatilor de masura, se va apela calea:

a) Format→Color;

b) Format→Layer;

c) Format→Units.

4. Sintaxa corecta pentru coordonatele polare ale unui punct aflat la distanta de 40 de unitati fata de originea sistemului si la un unghi de 300 este:

a) 40<30;

b) 30<40;

c) @40<30.

5. Pentru coordonatele relative se specifica:

      a. coordonatele raportate la originea sistemului de coordonate;

      b. coordonatele raportate la ultimul punct introdus ;

      c. coordonatele oarecare

6. Extesia fisierelor ce se realizeaza cu AutoCAD este :

a) *.dwg;

b) *.doc

c) *. txt

7. Sintaxa corecta pentru coordonatele polare relative ale unui punct aflat la distanta de 50 de unitati fata de ultimul punct introdus si la un unghi de 750 este:

a) 50<75;

b) 75<50;

c) @50<75.

8. Pentru stabilirea limitelor desenului, se va apela calea:

a) Format→Text Style;

b) Format→ Drawing Limitis;
c) Format→Units.

9. Comanda Pan are rolul:

a) Regenerarea completa a afişajului;

b) Măriri sau micşorări ale mărimilor aparente ale obiectelor ;

c) Translatează ecranul în orice direcţie fără schimbarea caracteristicilor desenului.

TEST 2

1. Care dintre urmatoarele comenzi creeaza linii infinite ?

a) LINE, RAY, SPLINE ;

b) RAY, XLINE ;

c) LINE, PLINE, RAY.

2. Comanda DONUT permite :

a) trasarea a doua cercuri concentrice, ale caror diametre se afla intr-un raport fix ;

b) Desenarea unui inel a carui grosime a liniei se specifica prin diametrul interior si cel exterior;
c) Trasarea unei linii infinite.
3. Elementele componente ale unei elipse sunt :

a) raza mare si centrul elipsei ;

b) diametrul si centrul elipsei ;

c) raza mare, raza mica si centrul elipsei.

4. Pentru definirea unui poligon cu ajutorul comenzii POLIGON, este necesara introducerea :

a) tuturor punctelor prin care trecdreptele componente ;

b) numarul de laturi si a coordonatelor centrului poligonului.

c) numarul de laturi si a coordonatelor unui cerc inscris sau circumscris poligonului.

5. Comanda ERASE poate fi folosita  la :

a) stergerea unui obiect

b) marirea/micsorarea unui obiect ;

c) crearea unui obiect.

6. Comanda COPY ii este specifica :

a) necesitatea definirii unei axe de simetrie ;

b) necesitatea definirii unui punct fata de care se va face copierea;

c) necesitatea stergerii unui element anterior

7. O caracteristica a comenzii MIRROR este :

a) copierea unui obiect;

b) nevoia de a defini o axa de simetrie;

c) crearea unui obiect.

8. Comanda ARRAY:

a) Creeaza o matrice ale carei elemente sunt copii ale unui corp dat;

b) editeaza un obiect;

c) sterge un obiect.

9. Comanda TRIM este utilizata la:

a) creearea unei linii ;

b) editarea razei unei elipse ;

c) stergerea dreptelor sau a segmentelor de dreapta nedorite dintr-un desen.

TEST 3

1. Pentru determinarea ariei unui obiect selectat, se va folosi comanda:

a) OFFSET ;

b) ID ;

c)  AREA.

2. La impartirea unui segment de dreapta in zece parti egale, cu ajutorul comenzii DIVIDE, programul va plasa pe dreapta :

a) 9 puncte oarecare ;

b) 11 puncte oarecare ;

c) 9 puncte aflate la distante egale.

3. Comenzile ERASE, OOPS, UNDO si REDO sunt folosite la :

a) corectarea greselilor ;

b) editarea obiectelor ;

c) salvarea desenului.

4. Comanda MTEXT ofera :

a) Scrierea pe mai multe randuri ;

b) Scrierea pe mai multe randuri si formatarea avansata a textului;

c) Scrierea pe un singur rand.

5. Culoarea unui obiect se poate schimba in cadrul ferestrei cu comada :

a) OSNAP ;

b) LAYER & LINETYPE PROPERTIES ;

c) SELECT COLOR.

6. Optiunea THICKNESS permite :

a) randarea unui obiect ;

b) adaugare de grosime unui obiect ;

c) stergerea unui obiect.

7. Calea de accesare a comenzii HATCH este :

a) DRAW→ HATCH;

b) FORMAT→ HATCH;
c) MODIFY→ HATCH.
8. Prin intermediul butonului  ADVANCED, se poate selecta :

a) culoarea hasurii ;

b) alegerea felului in care programul sa hasureze zonele islands;
c) iesirea din program.
9. Comanda BASELINE este folosita pentru:
a) schimbarea textului cotei ;

b) formatarea textului cotei ;
c) indică opţiunea de cotare în paralel (faţă de un element comun, considerat referinţă)
TEST 4

1. Comanda CENTER MARK:
a) schimba tipul de linie pentru cercul sau arcul de cerc luat in considerare;

b) marcheza un cerc sau un arc de cerc ;

c) marcheza centrul unui cerc sau al unui arc de cerc

2. Comanda WIREFRAME:

a) defineste un corp fara masa si fara volum;

b) defineste un corp cu masa si cu volum;

c) nu este un corp 3D.

3. Modelele SOLIDS permit:
a) definirea completa a unui corp 3D;

b) desenarea unor corpuri fara masa si fara volum;

c) desenarea unui cilindru.

4. Optiunea TOP, de vizualizare a unui desen, permite:
a) Vizualizare dedesuptul obiectului ;

b) Vizualizare  deasupra obiectului ;

c) Vizualizare pe diagonala.

5. Comanda BOX permite:
a) Desenarea unui cub;

b) Desenarea unui cilindru;

c) Desenarea unui tor.
6. Comanda PYRAMID permite:
a) desenarea unei piramide;

b) Desenarea unui tor;

c) Desenarea unui cilindru.

7. Comanda SHADE permite:
a) randarea desenelor;

b) trasarea de linii;

c) desenarea umbrita a desenelor.

8. Comenzile MOVE si ROTATE au in comun:
a) posibilitatea modificarii pozitiei unui obiect;

b) posibilitatea salvarii unui desen ;

c) pictograma butonului de pe bara de instrumente MODIFY

9. Comanda LINEAR DIMENSION este folosita pentru a cota:
a) raza unui cerc ;

b) un unghi ;

c) o dreapta.
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